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Toronto 2014 

le 5 et 6 juin / June 5 and 6 
 
Les préparatifs pour le congrès 2014 sont en cours. Le thème 
du congrès, « Tournons la page : index pour aujourd’hui et pour 
demain », reflète particulièrement bien ce qui se passe dans le 
monde de l’indexation d’aujourd’hui. Une réunion de 
planification du congrès a été organisée le 11 janvier à Toronto 
et nous avons accompli de grands progrès. Plus d’une 
douzaine de personnes se sont déjà portées bénévoles. Un 
grand merci à toutes et à tous! 

Conference 2014 plans are underway. Our theme reflects 
today’s indexing environment: “Changing Pages: Indexing for 
Today and Tomorrow.” A planning meeting was held in Toronto 
on January 11 and good progress was made. Over a dozen 
volunteers have already stepped up to the plate. Thank you! 

Nous avons commencé à dresser une liste de sites de congrès 
possibles dans le centre-ville de Toronto et travaillons à 
réserver l’intervenant principal. Nous allons également 
commencer à promouvoir le congrès à l’aide de plateformes de 
médias sociaux et à sécuriser des commanditaires. N’hésitez 
pas à nous informer de toute possibilité de commandite sous 
forme d’un service gratuit ou de distribution de matériel 
promotionnel par le biais de nos trousses de conférence 
dont vous auriez connaissance. 

Discussions have begun on securing a keynote speaker and 
which venue in downtown Toronto to book. Work on promoting 
the conference will begin now, using social media platforms. 
We’re also looking at potential sponsorship. If anyone knows of 
possible corporate sponsors—by way of a free service or 
branded “swag” for our conference packages—please let us 
know. 
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Nos membres devraient bientôt recevoir un autre courriel les 
invitant à se porter volontaire pour l’un des divers postes 
disponibles. Plus nous serons nombreux et plus la tâche sera 
facile, ce qui garantira le succès du congrès.  
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Membership Renewal 
 
Please remember that with the increased 
frequency of The Indexer, the grace period for 
renewing is shorter. To renew online, please go 
to the following link: 

http://indexers.ca/contact-us/renew-your-
membership/ 

Our mailing address is: 

The Membership Secretary, ISC/SCI 
P.O. Box 664, Station P 
Toronto, ON 
Canada M5S 2Y4 

Important: Please remember to add the ISC/SCI 
membership secretary to your list of people to 
contact when your details change. 

Audrey McClellan 
Membership Secretary 

 

Write for the Bulletin 
 
Author guidelines: Submit unsolicited articles 
electronically in Word or rich text format (*.rtf). 
Artwork should be in PDF format, and 
photographs in TIF or JPG format. Send 
submissions to Production Editor Marnie Lamb: 
lambmarnie@yahoo.ca. 
 
Board members: Christopher Blackburn, Moira 
Calder, Marnie Lamb, François Trahan, Gillian 
Watts.  
  

Advertise in the Bulletin 
 
Full page ………………CDN $80 
Half page ……………... CDN $40 
Quarter page ……….... CDN $20 
Business card ………... CDN $15 
 

Join the ISC/SCI 
 
Membership Categories and Fees: 
Individual………………… CDN $90 
Student…………………... CDN $60* 
Institution………………… CDN $105 
(Members outside Canada, add $10) 
 
*Student membership is available for full-time 
students only. Please inform ISC/SCI of your 
course name and institution. 
 
For more membership information, please visit 
http://www.indexers.ca/membership.html  
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Editor, Comments from . . . 
For arts and entertainment buffs this is awards season. We’ve already had the Golden Globes and the 
Grammys. This year the Academy Awards have been pushed back into March to make room for another 
awards-based series of competitions, the Winter Olympics. 

Indexers win awards too. 

Congratulations to Legislative Assembly of Ontario Hansard indexers and ISC/SCI members Cheryl Caballero, 
Erica Smith and Rosalind Guldner, Canada, who won first place in the American Society for Indexing Web and 
Electronic Index Special Interest Group (SIG) 2013 Web Indexing Award. For details on the criteria the judges 
used, you can check out the full report on the ASI site (http://www.web-indexing.org/award/2013.htm). 

The ISC/SCI is in the process of developing our own awards. As with the pop culture awards, these are an 
opportunity to acknowledge the achievements of our peers and to focus attention on our profession and 
professional standards. It is a major commitment for a small society such as ours, and the fact that some of our 
members—I can’t take credit—would take on a task like this is an indicator of the maturity of our profession in 
Canada and our confidence in our society and in our members. 

Take a bow, Cheryl, Erica, and Rosalind. The honour is well deserved. 

Moira Calder 
Bulletin Editor 

 

 

Conférence 2014 / Conference 2014 (suite de la page 1/cont’d from page 1) 

 
Members should expect to see an email soon requesting them to consider volunteering for one of many 
possible roles. Many hands will make light work for all and ensure a successful conference. New members are 
encouraged to volunteer. The conference is a great way to meet and get to know fellow indexers. Past 
volunteers are encouraged to fill roles as well, since we need the wisdom of experienced mentors too. 

Nous encourageons les nouveaux membres à se porter volontaire. Ce congrès est une occasion unique de 
rencontrer et de faire la connaissance de collègues indexeurs. Nous encourageons également nos anciens 
bénévoles à offrir leur contribution, car leur expérience et leurs conseils nous seront précieux.  

Looking forward to seeing you and working with you at the conference! 

Je me réjouis de vous revoir très bientôt et de travailler avec vous au congrès ! 

 

Margaret de Boer 
ISC Central Canada Representative/Conference Organizer 

Représentante SCI du centre du Canada / Organisatrice du congrès 
 

 

Upcoming Conferences 
The American Society for Indexing 2014 
conference will be held April 30 to May 3 at the 
Embassy Suites, Charleston Convention 
Centre, Charleston, South Carolina. ASI 
website: http://www.asindexing.org 

The Australian and New Zealand Society of 
Indexers (ANZSI) will next meet in 2015. 

The Society of Indexers (UK) will meet at 
Cirencester on September 5 to 7. The 
conference theme is “Tesserae to Tablets … 
Uncovering the Future.” SI website: 
http://www.indexers.org.uk. 

See page 1 for information on the ISC/SCI 
2014 conference. Website: 
http://indexers.ca/annual-conference 

http://www.web-indexing.org/award/2013.htm
http://www.asindexing.org/
http://www.indexers.org.uk/
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Co-presidents’ Report 

Rapport des co-présidentes 
 
From time to time the executive has discussed the possibility of an emeritus membership for long-
standing members of the society who are retiring from indexing but wish to remain connected with the 
group.  

Le bureau de direction a, à l’occasion, examiné la possibilité de créer un statut de membre émérite 
pour les membres de la société de longue date qui ne travaillent plus comme indexeur, mais qui 
désirent rester en contact avec l’organisation.  

Chris Blackburn, who has been a member since 1977, is no longer indexing on a regular basis. 
However, he would like to continue to contribute to the society, for example, by scanning early editions 
of the Bulletin (of which he has a complete set) to make them available to the archives. He could also 
send items to the current staff of the Bulletin as possible topics for a column on historical news and 
events. We are pleased to announce that Chris is our first emeritus member. Look for an interview with 
him in a forthcoming Bulletin. 

Chris Blackburn, membre depuis 1977, ne travaille plus régulièrement comme indexeur. Il aimerait 
cependant continuer à contribuer aux activités de la société; il propose par exemple de numériser les 
premières éditions du Bulletin (dont il possède une série complète) en vue de les archiver ou encore 
de faire parvenir au personnel actuel du Bulletin de possibles sujets pour la rubrique traitant de 
nouvelles et d’événements historiques. Nous avons le plaisir d’annoncer que Chris est notre premier 
membre émérite. Vous pourrez lire une transcription de l’entretien avec Chris dans une prochaine 
édition du Bulletin. 

The emeritus category of membership will have a nominal fee, but to mark Chris’s appointment as our 
first emeritus member, we are offering him the first year free. We will have more details on emeritus 
membership in the next issue of the Bulletin. 

Tout membre émérite de la société devra régler des frais d’adhésion minimes, mais comme Chris est 
le premier membre de cette catégorie, nous avons le plaisir de l’exempter des frais d’adhésion pour la 
première année. Nous vous fournirons davantage de détails sur cette nouvelle catégorie dans la 
prochaine édition du Bulletin. 

Meanwhile, we are making plans for the 2014 conference in Toronto. Contact Margaret de Boer, 
Central Canada representative, if you are interested in helping out. 

Nous sommes également en train de préparer le congrès 2014 à Toronto. Merci de contacter Margaret 
de Boer, représentante du centre du Canada, si vous désirez contribuer.  

We hope everyone is enjoying our “classic” winter this year. By the time of the conference we’ll hardly 
remember how cold it’s been! 

Nous espérons que vous aimez l’hiver « du bon vieux temps » cette année. Au moment du congrès 
nous aurons surement tous oublié ce froid! 

Mary Newberry and Jennifer Hedges, Co-presidents / Co-présidentes 
Indexing Society of Canada / Société canadienne d’indexation 

 
  Late issue of the Bulletin 

Please accept my apologies for the lateness of this issue of the Bulletin. The responsibility for production 
is mine, and I take full responsibility. 

I apologize in particular to those who look forward to Heather Ebbs’ crossword puzzles. Too late for 
Christmas 2013, it will appear in next winter’s issue. 
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Book Review: 

Personal Archiving: 

Preserving Our Digital Heritage 

edited by Donald T. Hawkins 

Medford, NJ: Information Today, 2013 
 

Personal archives are defined as “collections of digital material created, collected, and curated by 
individuals rather than institutions.” Aaron Ximm of the Internet Archive refers to such archiving as 
being “on behalf of, and (at least for some period) exclusively for, the use of an individual person or 
institution.” Personal Archiving: Preserving Our Digital Heritage is a collection of 13 papers on various 
aspects of personal archiving that range from organizing and preserving one’s personal photo 
collection to technical and academic papers for specialists in the field. 

Specific topics covered include case studies of personal archiving by individuals and families; an 
overview of the US Library of Congress’s involvement with public libraries to provide practical 
information to individuals; software for personal archiving; legal and ethical issues around digital 
inheritance and privacy rights; the impact of social media; an introduction to the Internet Archive; and 
current research and product development. In an area that is constantly changing, readers will be able 
to stay current with much of the information by following the many links to websites. For example, not 
long ago the only way to preserve email was to print it out. Now there are programs such as MailStore 
Home that manage and archive emails. 

I read this book from the viewpoint of someone involved in the ISC/SCI project to identify, collect, and 
organize material of permanent value to ISC/SCI. Our collected archival material is at present mainly 
paper, but it has begun to shift to digital. In many ways digital archives are no different than paper 
archives—the information in both records the history and development of the subject—but digital 
archives have the added challenge of “invisibility.” They can get lost or accidentally deleted, they can 
end up being stored on obsolete media, or they can be hosted on a service provider that goes out of 
business, taking its collections with it.  

It was fascinating to read about the Salman Rushdie archive at Emory University, which includes his 
files on the actual computers he wrote on over the years. Another chapter that I completely enjoyed 
was “Reading Ben Shneiderman’s Email: Identifying Narrative Element in Email Archives,” a research 
project involving almost 45,000 emails and more than 4,000 relationships. 

The publisher’s intended audience is consumers, academic researchers, librarians, historians, public 
officials, and local historical societies. I believe the compilers have been successful in providing 
something of value to each of these groups. Personal archiving provides an alternative to institutional 
archives such as those housed in libraries and universities, and it is well worth exploring. 
 

Jennifer Hedges 

 

 

 
 

ISC/SCI website: http://www.indexers.ca 

The members’ area contains newsletters of our sister societies and website updates. 

http://www.indexers.ca/
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Regional Reports 
 

British Columbia 
The biggest event of the recent year was my 
first-ever trip to the Frankfurt Book Fair in 
October. I had a very interesting day overall, 
and very much enjoyed being part of the 
meeting of the German Network of Indexers (in 
German DNI) in the afternoon. I was their first 
guest from Canada! It was great to finally meet 
Jochen Fassbender, coordinator of the DNI, as 
well as several of their members, in person. At 
Maureen McGlashan’s request I am writing a 
short article for The Indexer on the subject. 

I am particularly excited about a new 
embedded indexing software that was 
introduced at the meeting: smart-index, by 
abavo. It is still in the development stage but 
has already been used to produce one book, 
just in time for the trade show. That book’s 
publisher was present and reported next to no 
impact on their production process—a very 
promising assessment. Key to the software is 
adoption by publishers, as smart-index 
requires the insertion of anchors in the text 
during the design phase. The big advantage 
for indexers is that we can work with the file 
without having to own InDesign or another 
expensive program, and that it is designed to 
work with our own familiar indexing software 
(presently tested with CINDEX and SKY). The 
developers are working closely with both 
indexers and publishers to create a win-win 
situation for everyone. Their website 
(http://www.abavo.de) is currently available 
only in German, and a dedicated smart-index 
page is not yet operational, but I will keep an 
eye on this. 

Because of my trip to Frankfurt I deferred 
any local activity until after that date. I am now 
organizing a pair of meetings for November: 
one in Vancouver, one in Victoria. In addition 
to my own report on the book fair, I am hoping 
to get insights from a couple of people who 
attended this year’s conference in Halifax, 
since a good number of us didn’t make the trip 
this time. I am also inviting a member of the 
DNI who lives in the Vancouver area. 

With Audrey’s help (also thanks to 
François) I was able to update the list of local 
members and our group mailing list. 

Isabel Steurer 

 
Jochen Fassbender (left) and Walter Greulich of 

the German Network of Indexers (DNI). 
 

Central Canada 
Here’s a synopsis of our meetings in the 
Toronto area since the conference. Our 
attendance averages around 12–15 members, 
and occasionally a lapsed or non-member 
attends. Mary Newberry and I, with Heather 
Ebbs, have talked about getting an Ottawa 
meeting organized. Nothing in the works so 
far, but hopefully a good date will work out 
eventually. We’re thinking of ways to more 
accurately reflect Central Canada, because in 
reality the Toronto area is what is being 
represented. 

At our June meeting, those who attended 
the conference in Halifax shared their 
experiences. We discussed Elaine Menard’s 
images indexing project and Harry Bego’s 
presentation on TExtract. This led us into a 
discussion of e-books and indexing. Many of 
us had more questions than answers, but it did 
lead to Mary’s getting Erin Mallory from House 
of Anansi Press to speak to us at our recent 
October meeting. 

In July we had a social and food-themed 
event at Mary’s home and casually went 
around the table, sharing what we’ve been 
doing lately. Our latest two meetings have 
been held where the executive now meets: the 
Centre for Social Innovation. We’re pleased 
with this new venue. Thanks, Mary! 

 
 

ACROSS  
 

1. Chicago "family" man 
7. Seldom 
13. Letter-perfect order? 
16. Home state of author Stauber 
17. Famed flyer 
18. __ Lanka 
19. Indexer near the heart of a 

practical joker? 
21. Feline 
22. Indexer's aid 
23. On 
24. Something for 17 Across to do? 
26. Sister soc. 
27. Golfer's desire 
29. Cyberspace, informally 
31. Competed 
32. He makes either catsup or 

ketchup 
34. Place for golfers to drive 
37. Complaint 
40. Wondrous author with indexers in 

his heart? 
45. Tellers of 11 Down 
47. French of 
48. Waist garb 
49. Neck garb 
50. Ship's lowest deck 

http://www.abavo.de/
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In September we peer-reviewed a fellow 
indexer’s work. At our October meeting we 
were all excited to listen to Erin Mallory speak 
about e-books and indexing. She gave an 
overview on the development of e-books and 
then a detailed explanation on the processes 
of indexing in this format. She provided us with 
a good list of resources to further explore this 
area. Those present gave a hearty round of 
applause at the end. Erin offered her 

PowerPoint presentation, which I circulated to 
our members. She would be a valuable person 
to lead a seminar at the conference.  

For future meetings, I would like to see 
more discussions on e-books. If others have 
suggestions on who to ask or what resources 
to explore, I’d be happy to hear from you. 

 
Margaret de Boer 

 
 

  
Links 
Here’s hoping you got some time over the holidays to let your mind wander over wide territory. 
Maybe the new year will see you exploring new interests or revisiting old ones. 

Full-text books 

 The Online Books Page provides a portal to online books: digital.library.upenn.edu/books. 

 Project Gutenberg: www.gutenberg.org. 

 Bartleby has full text and, of course, a search engine for quotations: www.bartleby.com. 

 The Christian Classics Ethereal Library has public-domain versions of books from the early 
Church Fathers to nineteenth-century authors: http://www.ccel.org/. 

Special-interest libraries and museums 

 EEA AirVenture Museum includes a virtual tour: 
http://www.airventuremuseum.org/virtual/interactive/.  

 The Rock and Roll Hall of Fame library has links to many music-related sites: 
http://library.rockhall.com.  

 Alexander Street Press has some free resources available at 
http://alexanderstreet.com/support-center/resources. Many databases are available by 
subscription (http://amso.alexanderstreet.com/), so check your local library to see if it’s a 
subscriber. (The Calgary Public Library is on the list, for example.) 

 Kent State University Museum has a strong fashion focus, including browsable features 
such as an online costume gallery: http://www.kent.edu/museum.  

 Not sure what you want to look for, or looking for something specific or rare? Try one of 
these: 

o Archive Finder: http://archives.chadwyck.com. 
o ArchiveGrid: http://archivegrid.org. 

Moira Calder              

Sources 

Hock, Randolph. The Extreme Searcher’s Internet Handbook, 4th ed. Medford, NJ: CyberAge 
Books, c. 2013. 

MacLeod, Don. How to Find Out Anything. New York: Prentice Hall, 2012. 

file:///C:/Users/Moira/Desktop/Bulletin%20from%20HP%20laptop/13-12%20Bulletin%20drafts/digital.library.upenn.edu/books
http://www.gutenberg.org/
http://www.bartleby.com/
http://www.ccel.org/
http://www.airventuremuseum.org/virtual/interactive/
http://library.rockhall.com/content.php?pid=290460&sid=2393699
http://alexanderstreet.com/support-center/resources
http://amso.alexanderstreet.com/
http://www.kent.edu/museum
http://archives.chadwyck.com/
http://archivegrid.org/
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The Indexing Body: 

Some Issues of Care and Comfort 

in Pursuit of the Great Naming Game 

Part 3: Shoulder, Neck, and Back Issues  
 

To begin, please note: Here be dragons! The matrix of issues is mind-boggling, and the literature and advice 
are full of conflicting opinions. Experiment and experience are called for. I found many sources of information, 
and one of the most helpful was an excellent online article by T. J. Salih.

1
 A review of this article will certainly 

repay the effort; the illustrations, in particular, are simple, clear, and highly usable. 

In order to reduce complexity and heighten clarity, even at the risk of oversimplification, I will combine what I 
believe to be the two most crucial considerations for reducing problems in these areas of the body. They are 
distance and posture—the two are inextricably related. In combination they lead to an unusually common 
conclusion in the literature: that laptops are definitely not the way to go for extended computer usage. Yet 
laptops are rapidly displacing (have displaced?) desktops as the preferred technology. I noticed this several 
years ago, when I went about replacing an aged desktop. In every store I checked, there were at least five or 
six laptop models to every desktop computer.  

Now, budgets being what they are, we all have to make this difficult decision at some point, but the issue is 
really quite resolvable. Fitting up a laptop with a wireless keyboard and an extended monitor means that all the 
portable convenience of the laptop can be retained while dealing fully with the key issues of distance and 
posture. And since both the bulk and the cost of monitors have been halved several times over the past 
decade, this solution should not prove to be the space- and budget-buster it was in the previous millennium. 
Even better, once I added a monitor to my laptop, I found that the extended screen space offered seriously 
enhanced comfort and convenience. 

That said, a little more about posture. First, invest in a very good, highly adjustable chair, one with comfortable 
lumbar support. Keep your feet flat on the floor or on a sloped footrest, thus ensuring full benefit from the 
lumbar support.

2
 Be sure to adjust the chair height to your optimal desk height in order to reduce any possibility 

of unnecessary strain. (All of this is highly personal, completely dependent on one’s skeletal structure.)  

Second, consider how you will provide forearm support for those extended work sessions. Attentiveness to this 
issue will assist in avoiding or reducing the effects of problems such as carpal tunnel syndrome, as well as 
shoulder and neck discomfort. I’m right-handed, and since my work calls for constant use of the mouse, I have 
experienced significant fatigue and discomfort in that wrist and forearm. Over the past year I jury-rigged a 
padded armrest extension from desktop to chair, so that my forearm and wrist are fully supported and my hand 
sits just over the mouse. For some time now I have also used a gel-pad strip just in front of the keyboard; this 
offers comfortable wrist support while placing the fingers just over the keys. These adjustments (see Figure 1) 
all seem to work quite well.  

Finally, at the risk of sounding like a nagging mother, keep your shoulders back and your neck straight. There 
is a very basic reason for this advice, as T. J. Salih notes:  

The average weight of an adult head weighs between 8–12 lb, so 12 lbs of force need to be generated by 
the neck and shoulder muscles to hold your head up. If your head falls forward . . . the muscles now need to 
generate 36 lbs of force to hold your head up. After a period of time, this amount of force generation will 
cause fatigue and pain.

3 

As with the eyes, so with the rest of package. Frequent movement is the key. Move and stretch in place, stand 
up, stretch, engage neck and shoulders in gentle motions, stretch. Or, if you prefer, consider this variant on the 
old football chant: “Swing to the left, swing to the right, stand up, sit down, type, type, type!” 
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What follows now is beyond the norm, but I found these expedients helpful for the back-pain incident that 
prompted these investigations. When my discomfort got to the point where I just couldn’t sit in front of a monitor 
any longer, I retired to a recliner. After several weeks I had found relief and returned to the desk. But I had also 
decided that some variety was warranted. Over several months of experimentation I came up with two 
alternative work postures. The first involved a desk arrangement that allows for working while standing (see 
Figure 2). I have since read that some folks have combined a stand-up desk with an electronic treadmill 
arrangement. The drive-belt speed is set low enough to provide for continual body motion without distracting 
overly from the work at hand. I haven’t tried that one.  

  

Figure 1: My workspace, 
showing an inclined footrest, 
the extended right armrest to 
support mouse usage, and 
the gel-pad wrist rest in front 
of the keyboard. 

 

Figure 2: A modified stand-up 
arrangement, with keyboard and 
mouse and the monitor placed 
vertically for ease of reviewing a 
larger range of index records on a 
single screen. Just barely noticeable 
under the chair is a padded stand-on 
strip intended to ease back strain. 
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For a second work-posture variation, I improvised a swing-arm table assembly holding a laptop fitted with an 
added keyboard and monitor. This enables me to work in a recliner (see Figures 3 and 4). The benefit is that 
any strain on the lower back and tailbone is greatly eased. In this position I have yet to perfect the best method 
for mouse usage. I find that wrist and forearm tire much more quickly than while working at the desk, so 
obviously the profile is not the best. But it works well for when I am proofreading scanned text against digital 
format, and for editorial tasks associated with indexes, in which mouse use is more restricted. Still, I have a 
confession: while both of these arrangements work well enough (with some limitations), I find that I instinctively 
prefer the sit-down posture. Habits do die hard! 

 

Figure 4: The recliner arrangement in closed (operational) configuration. Note that the monitor is located 
immediately above the keyboard and tilted for optimal viewing pleasure.  

Figure 3: The recliner arrangement, 
opened up to show how it is 
organized. 
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Quick Tips 

 Chair and desk: Ensure optimal alignment for you.  

 Monitor: Ensure optimal distance and height.  

 Laptop: Provide auxiliary keyboard and monitor. 

Notes 

1. T. J. Salih, “Avoiding Back Pain and Neck Pain Whilst Working at a  
Computer.” PhysioRoom.com, last modified July 1, 2003, accessed February 19, 
2012. http://www.physioroom.com/experts/asktheexperts/answers/qa_ 
20030701.php. Salih is Senior Chartered Physiotherapist at the  
back2normal back and neck clinic, London (UK). 
2. Ibid. 
3. Ibid. 

Recommended Reading 

Lunau, Kate. “Don’t Just Sit There.” Maclean’s, January 14, 2013, 14–16. 

 
 

ISC/SCI Membership Report for December 2013 
 
As of October 25, 2013, we had 113 members. Six new members have joined since May. Thirteen 
members did not renew their memberships, which expired at the end of June. The geographical 
breakdown of the membership is as follows. 

Within Canada 

British Columbia 31 
Alberta   6 
Saskatchewan   2 
Manitoba   0 
Ontario 48 
Quebec 12 
New Brunswick   1 
Newfoundland & Labrador   2 
Nova Scotia   2 
Prince Edward Island   1 

Outside Canada 

United States     7 
Italy     1 

Membership Types 

Individual  105 
Student      2 
Institutional      6 

 
Institutional members are distributed as follows: 
 
Alberta            1 
Ontario           3 
Quebec           1 
United States           1 
 

The following members have joined since the annual report: 

Brenda Belokrinicev, Athabasca, AB, belok@telus.net 
Louis Crust, Toronto, ON, LC@ametro.net 
Alberta Hansard, Edmonton, AB 

Audrey McClellan 
Membership Secretary 

 

You can purchase or 
renew an ISC/SCI 

membership online 
using PayPal. 

 
Brian Hogan has written 
a four-part article on 
health issues for 
indexers and other desk-
bound professionals. 

Congratulations to Chris Blackburn, ISC/SCI’s first emeritus member. 

Details are in the report of the co-presidents, on page 3. 

http://www.physioroom.com/experts/asktheexperts/answers/qa_20030701.php
http://www.physioroom.com/experts/asktheexperts/answers/qa_20030701.php
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More Sorting in CINDEX™: 

Tips and Techniques from Indexing Research 
 

In an earlier column on this topic I described two basic sorting conventions employed in indexing—
word-by-word and letter-by-letter—and how different authorities (e.g., International Standards 
Organization, Chicago Manual of Style) as well as individual publishers’ style guidelines place varying 
spins on these two conventions. CINDEX still provides these established protocols, as well as 
customizable “exceptions,” but this column will outline additional sorting options that are available in 
CINDEX version 3 (released May 2012). Added to the sorting protocols are those recommended by 
the Society for Biblical Literature (SBL) for handling the order of chapter:verse citation constructs for 
both word-by-word and letter-by-letter protocols. 

Since CINDEX 3 is now fully Unicode compatible, and thus able to accept and retain all foreign 
characters in entry records, we have also provided recognized collation options for a number of 
different languages. The default language when applying sort protocols is English, but if you are writing 
an index in Afrikaans, Arabic, Danish, German, Hebrew, Serbian, or Welsh, you can find collation 
options for these and 54 other languages in the Tools menu under Sort/Language. If you want to insert 
characters common in these different languages, they can be found in the Edit menu under Special 
Characters (Mac) or Character/Character Map (Windows). 

The default setting for sorting is still a “simple sort,” in which each character is sorted according to its 
computer (ASCII) value. This means that any main heading that begins with a quotation mark will float 
to the top of the index. Other characters that have special significance for hiding and forcing placement 
during sorting, such as < > and { }, will also be evaluated according to their character value—in this 
case placing them at the end of the index. All headings beginning with alpha characters will file where 
you expect to see them. So to file entries beginning with quotation marks or special characters (as 
mentioned above) in their correct places, you need to select one of the sort protocols in the Tools 
menu, under Sort/Alphabetizing Rule. 

You can still sort index entries by their locators: by using the AZ and 19 icons on the index tool bar 
to switch easily between a basic alphabetic sort and a page sort. A page-order sort is useful for 
checking entries against page proofs, revising an existing index, or providing clients with a page-
ordered index file (in addition to your final alphabetized file) so they can easily locate entries should 
they need to make adjustments for last-minute movement of text.  

It is worth remembering that when sorting by locator, CINDEX will sort only by the first locator entered 
in the page field of any record. For example, a page field containing the locators 12, 45, 78 will appear 
only among the other entries sorted at page 12, so you will need to expand the index (use the Tools 
menu/Expand). The entry will then show in three positions: at pages 12, 45, and 78.  

The opposite of sorted is unsorted, and CINDEX can display the index in this manner too. In most 
cases it will reflect the order in which you write and add entries to the index. To change to unsorted 
order, go to the View menu and click on Sorted. This removes the checkmark and “unsorts” the index. 
The word “Unsorted” will appear in the status bar at the bottom of the index. To further confirm that the 
index is indeed unsorted rather than sorted, you can choose to display the number assigned to each 
record, by going to the View menu and selecting Show Numbers. Please note that you will see the 
numbers only when you are in Draft View. 

CINDEX also sorts subheadings under any heading term by ignoring leading prepositions and 
conjunctions. The list of default subheading prefixes is in the Sort menu at Ignore Subheading 
Prefixes. This list can be edited as you wish. For example, if you want CINDEX to sort on (rather than 
ignore) the subheading prefixes, simply highlight the whole list and press the Delete key to remove 
them. This list was also used to determine the correct position of prepositions and conjunctions when 
exchanging field levels with a “smart flip.” In CINDEX 3 this positioning is now controlled by a separate 
list that can be edited to suit your needs. You can find this new list in the Document menu at Smart Flip 
Words (both Mac and Windows). 
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Two other points to bear in mind, for when you need to display the index in an appropriate way for the 
task at hand: 

 You can arrange the whole index according to the content of any subheading level. This is 
useful when you want to ensure complete consistency of wording of the subheadings. 

 When you make a group (temporary or otherwise) as the result of Find, you can sort the group 
quite differently from the sort in effect for the index as a whole. Just use the tool bar icons.  

Frances S. Lennie 
flennie@indexres.com 

Note 

Past CINDEX columns will be available shortly on the Indexing Research website at  
www.indexres.com. 

 

 

 

Student Perspective: 

University of California-Berkeley 

Indexing Course 
 

I love working with books. Knowing that, and in search of a better job last year, when I read about 
indexing as a career, it looked intriguing. A bit more research and I had decided to go for it. I found 
myself in search of a course I could take on indexing. There were definitely a few options out there 
too—different university courses, for example, and some of the indexing societies have courses as 
well. Almost too many options to choose from on my own. So I posed the question to the indexers’ 
discussion list on Yahoo! The responses came back, with quite a number recommending the indexing 
course offered by the University of California at Berkeley. 

Going over the syllabus as shown on Sylvia Coates’s website was what made me decide on this 
course. Some of the clinchers included being able to thoroughly experiment with all three of the major 
indexing software packages, as well as having the opportunity through the assignments to work on 
several different types of indexes, both short and long. 

They have an interesting format for the first few assignments, the short ones. Each one is split into 
three parts, one for each of the major programs. So take the name index assignment as an example: 
there’s a list of about 10 or so names for each part. You’ve got to figure out how to enter them for 
correct sorting, learning how to use the various resources out there for that, but at the same time 
they’re picked so you’re also learning how to enter various special characters and accents. That’s all 
on top of learning how to enter and format the assignments in MACREX, CINDEX, and SKY, so each 
of these little assignments serves multiple purposes. 

After that, you start working on actual articles of varying length and topics, using your choice of 
indexing program; there’s no longer a requirement to use all three programs once you reach the longer 
assignments. These longer assignments start getting closer to actual job-style indexes, including 
differing submission requirements. 

There is a very high teacher-to-student ratio, with four teachers involved in the course, and over the six 
months you have plenty of opportunity to ask questions of all of them. Each week there’s a one-hour 
chat session open to current students, hosted by one or two of the teachers. As a result you get to 
“meet” all the teachers, who are very easy to talk to and ask questions of, although you have one 
primary teacher who marks your work. 
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There are two key things about the Berkeley course that you should know, however. First is this: your 
period of access starts the day you register, so the cut-off date is six months to the day from that date. 
This is definitely something to be aware of when you register; I did so over Christmas, under the 
mistaken impression that the course would start with the new semester in January. Did I ever get a 
surprise! The second thing is that this is a self-paced course, so it is very easy to keep thinking you’ve 
got lots of time to work on it and then end up leaving everything to the very end. 

The various readings, both required and suggested, were very helpful, including the Chicago Manual 
of Style and Nancy Mulvany’s Indexing Books (2nd ed.) as required published books. A list of 
suggested readings/resources for newer indexers is also provided in the course documents. All of 
those that I’ve purchased have proven to be very interesting, and useful too at times for the various 
assignments, including the Webster’s Biographical Dictionary, Facing the Text by Do Mi Stauber, and 
Hans Wellisch’s Indexing from A to Z. 

The course is offered by an American institution and I’m Canadian. How different are the standards 
here? Throughout the course readings there are little boxes marked with a Canadian flag noting 
differences between standards in indexing and terminology, such as differing average deadline 
lengths, a reminder that we use two different types of spelling, business requirements (mostly in the 
form of pointers to the appropriate website), and so on. And it’s not just for Canadian material; there 
are tips for Australia as well. All these additions are thanks to two of the teachers: our own Heather 
Ebbs (for the Canadian tips) and Max McMaster (for the Australian ones). 

Coming out of the course, I’m feeling confident and looking forward to finding my first jobs as an 
indexer. 

Elena Gwynne 

Note 

Indexing Theory and Application (X477) is part of the UC Berkley extension program and is a 
standalone course. Further information can be found on the Berkeley website at 
http://extension.berkeley.edu/catalog/course394.html, and on Sylvia Coates’s webpage on the course, 
at http://www.sylviacoates.com/uc-berkeley-extension-indexing-course.html. 

 

 

 

 

A young magpie. Photo by Dirk Baunack available for free distribution worldwide 
under the German Wikipedia Project. 

http://extension.berkeley.edu/catalog/course394.html
http://www.sylviacoates.com/uc-berkeley-extension-indexing-course.html.

